
Q.1 कोलॉइड और वास्तविक विलयन के  बीच निम्नलिखित में से कौन-सा विशिष्ट अंतर होता है?
Ans 1. वास्तविक विलयन में दृश्यमान विलेय कण होते हैं, जबकि कोलॉइड में अदृश्य परिक्षिप्त कण होते हैं।

2. वास्तविक विलयन ब्राउनियन गति दर्शाते हैं, लेकिन कोलॉइड नहीं  दर्शाते हैं।

3. वास्तविक विलयन में एकल-प्रावस्था तंत्र होता है, जबकि कोलॉइड में द्वि-प्रावस्था तंत्र होता है।

4. वास्तविक विलयन टिंडल प्रभाव निरूपित करते हैं, लेकिन कोलॉइड नहीं  निरूपित करते हैं।

Q.2 किसी फार्मूले में सेल रेफरेंस को एडिट करते समय, एमएस एक्सेल में F4 कुं जी का प्राथमिक कार्य क्या
होता है?

Ans 1. फाइंड एं ड रिप्लेस (Find and Replace) डायलॉग ओपन करता है

2. पिछले एक्शन को रिपीट करता है

3. ऐब्सोलुट और रिलेटिव रेफरेंस के  बीच टॉगल करता है

4. वर्क शीट को रिफ्रे श करता है

Q.3 रे डियोसक्रिय समस्थानिकों  (radioactive isotopes) के  उपयोग से प्राप्त ऊर्जा को ______________
कहा जाता है।

Ans 1. नाभिकीय ऊर्जा

2. सौर ऊर्जा

3. ऊष्मीय ऊर्जा

4. भूतापीय ऊर्जा

Q.4 तेंदुलकर पद्धति के  अनुसार, 2011-12 में ग्रामीण क्षेत्रों  में गरीबी रेखा से नीचे रहने वाले व्यक्तियों का
अनुमानित प्रतिशत कितना था?

Ans 1. 15.5%

2. 20%

3. 25.7%

4. 27.5%

Q.5 निम्नलिखित में से कौन-सा, चिमनियों  का स्रोत नहीं  है?
Ans 1. प्रगालक

2. ताप विद्यु त संयंत्र

3. उद्योग

4. नदियाँ
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Q.6 निम्नलिखित में से कौन-सा, ऐलुमिनियम और सल्फे ट आयनों द्वारा निर्मित यौगिक के  रासायनिक सूत्र को
सही प्रकार से निरूपित करता है?

Ans 1. Al(SO₄)₃
2. Al₃(SO₄)₂
3. Al₂(SO₄)₃
4. Al₂SO₄

Q.7 किस अनुच्छे द के  अंतर्गत मंत्रियों  को मताधिकार के  बिना संसदीय कार्यवाही में भाग लेने का अधिकार
प्रदान किया गया है?

Ans 1. अनुच्छे द 77

2. अनुच्छे द 53

3. अनुच्छे द 88

4. अनुच्छे द 78

Q.8 किसी स्मार्टफोन या टैबलेट को सुरक्षित करने का पहला स्टेप क्या है?
Ans 1. के वल मुफ़्त वाई-फ़ाई नेटवर्क  का उपयोग करना

2. अधिक ऐप इंस्टॉल करना

3. मोबाइल डेटा बंद करना

4. पासवर्ड/पिन-प्रोटेक्टेड लॉक स्क्रीन सेट करना

Q.9 सहस्राब्दि विकास लक्ष्य (Millennium Development Goals - MDG) का लक्ष्य किस वर्ष तक अत्यंत
निर्धनता को कम करना है?

Ans 1. 2014

2. 2015

3. 2008

4. 2005

Q.10 सबसे अधिक ध्वनि ___________ से उत्पन्न होती है।
Ans 1. वाहनीय उत्सर्जनों से

2. जेट विमान के  उड़ान भरने से

3. घर की चिमनियों से

4. औद्योगिक धुएं

Q.11 91वें संशोधन अधिनियम के  अनुसार, मंत्रिपरिषद में प्रधानमंत्री सहित मंत्रियों  की अधिकतम संख्या
कितनी है?

Ans 1. लोकसभा सदस्यों की संख्या का 10%

2. लोकसभा सदस्यों की संख्या का 15%

3. लोकसभा सदस्यों की संख्या का 20%

4. लोकसभा सदस्यों की संख्या का 12%

Q.12 जब कं प्यूटर को स्लीप मोड में रखा जाता है, तो क्या होता है?
Ans 1. यह कु छ मिनटों के  बाद अपने आप रीस्टार्ट हो जाता है।

2. यह हार्ड ड्रा इव पर डेटा स्टोर करता है और पावर ऑफ कर देता है।

3. यह पूरी तरह से बंद हो जाता है।

4. यह न्यूनतम बिजली का उपयोग करते हुए RAM में सेशन को एक्टिव रखता है।

Q.13 प्रिंट सेटिंग में, कोलेशन (Collation) ऑप्शन का उद्देश्य क्या है?
Ans 1. डॉक्यूमेंट के  सभी पेजों को एक सेट के  रूप में प्रिंट करना

2. कस्टम प्रिंट रेंज को सेलेक्ट करना

3. प्रिंटर सेलेक्शन को बदलना

4. पेज ओरिएं टेशन को एडजस्ट करना
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Q.14 जनवरी 2025 में, देहरादू न में आयोजित 38वें राष्ट्री य खेलों  का उद् घाटन निम्नलिखित में से किसके  द्वारा
किया गया?

Ans 1. पुष्कर सिंह धामी

2. नरेंद्र मोदी

3. अनुराग ठाकु र

4. द्रौपदी मुर्मू

Q.15 आयु के  साथ पक्ष्माभिकी पेशी के  कमजोर होने के  कारण कौन-सा दृष्टि दोष हो जाता है?
Ans 1. प्रेसबायोपिया (Presbyopia)

2. हाइपरमेट्रो पिया (Hypermetropia)

3. मायोपिया (Myopia)

4. एस्टिग्मेटिज्म (Astigmatism)

Q.16 उदासीन लवण विलयन का pH लगभग कितना होता है?
Ans 1. 7 के  बराबर

2. 7 से कम

3. 7 से अधिक

4. ताप पर निर्भर करता है

Q.17 2025 ग्लोबल फायरपॉवर (GFP) इंडेक्स में भारत की वैश्विक सैन्य रैं किं ग क्या है?
Ans 1. तीसरी

2. दू सरी

3. पाँचवी

4. चौथी

Q.18 Mg²⁺ और PO₄³⁻ आयनों के  बीच बनने वाले यौगिक के  लिए सही सूत्र की पहचान कीजिए।
Ans 1. Mg₃(PO₄)₂

2. MgPO₄

3. Mg(PO₄)₃

4. Mg₂(PO₄)₃

Q.19 जब कोई अम्ल किसी धातु ऑक्साइड के  साथ अभिक्रिया करता है, तो क्या होता है?
Ans 1. के वल जल का निर्माण होता है।

2. एक लवण और जल का निर्माण होता है।

3. के वल लवण का निर्माण होता है।

4. एक लवण और हाइड्रो जन गैस का निर्माण होता है।

Q.20 स्लाइड शो को शुरुआत से स्टार्ट करने के  लिए किस शॉर्टकट कुं जी का उपयोग किया जाता है?
Ans 1. Shift + F5

2. Ctrl + P

3. Alt + Tab

4. F5

Q.21 यदि संतुलित बल लगाया जाए, तो किसी वस्तु पर लगने वाला निवल बल कितना होगा?
Ans 1. अनंत

2. त्वरण के  बराबर

3. शून्य

4. वस्तु के  द्रव्यमान के  बराबर
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Q.22 1956 के  औद्योगिक नीति संकल्प में उद्योगों  को कितने वर्गों में वर्गीकृ त किया गया था?
Ans 1. सात

2. पांच

3. तीन

4. नौ

Q.23 Which of the following is NOT toxic to non-target organisms in the soil?
Ans 1. Pesticides

2. Fungicides

3. Herbicides

4. Organic fertilisers

Q.24 बार-बार परावर्तन के  कारण ध्वनि निर्बंध की परिघटना ___________ कहलाती है।
Ans 1. विवर्तन

2. अपवर्तन

3. अनुरणन

4. अनुनाद

Q.25 यदि आप चाहते हैं कि प्राथमिक प्राप्तकर्ता यह देख सके  कि अन्य लोगों  को भी ईमेल की कॉपी प्राप्त हुई
है, तो आपको _______ फ़ील्ड में उनके  ईमेल पते दर्ज करने हों गे।

Ans 1. Subject

2. To

3. Cc

4. Bcc

Q.26 The main use of chlorofluorocarbons is in __________.
Ans 1. vehicles

2. refrigerants

3. chimneys

4. smog

Q.27 विद्यु त-परिपथ में, एमीटर को जोड़ने का सही तरीका क्या है?
Ans 1. स्रोत के  साथ समानांतर क्रम में

2. घटक के  साथ शृंखला क्रम में

3. घटक के  समानांतर क्रम में

4. या तो शृंखला अथवा समानांतर क्रम में

Q.28 निम्नलिखित में से किसे वैश्‍विक ऊष्मन (global warming) को नियंत्रित करने के  उपाय के  रूप में नहीं
माना जा सकता है?

Ans 1. जीवाश्म ईंधन के  उपयोग में कटौती

2. ऊर्जा का कु शलतापूर्वक उपयोग

3. वनोन्मूलन का कारण

4. ग्रीनहाउस गैसों के  उत्सर्जन में कमी

Q.29 जनवरी 2025 में, निम्नलिखित में से किस शहर द्वारा प्रथम खो-खो विश्व कप की मेजबानी की गई?
Ans 1. चेन्नई

2. मुंबई

3. कोलकाता

4. नई दिल्ली
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Q.30 ताप बढ़ने पर पदार्थ की कौन-सी अवस्था सर्वाधिक विस्तार दर्शाती है?
Ans 1. द्रव

2. ठोस

3. गैसें

4. प्लाज्मा

Q.31 डॉ. बी.आर. अंबेडकर ने भारतीय संविधान के  किस भाग को इसकी 'अनोखी विशेषता' बताया, जबकि
ग्रैनविल ऑस्टिन ने इसे 'संविधान की अंतरात्मा' के  रूप में संदर्भित किया?

Ans 1. राज्य नीति के  निर्देशक सिद्धांत

2. उद्दे शिका

3. मौलिक कर्तव्य

4. मौलिक अधिकार

Q.32 यदि किसी वस्तु को विरामावस्था से गिराया जाए, तो 15 सेकं ड बाद उसका वेग कितना होगा? (g = 9.8
m/s²)

Ans 1. 145 m/s

2. 143 m/s

3. 147 m/s

4. 149 m/s

Q.33 रुद्र वीणा, मुख्य रूप से हिंदुस्तानी संगीत की किस शैली से संबंधित है?
Ans 1. ठु मरी

2. ग़ज़ल

3. ध्रुपद

4. ख़याल

Q.34 प्लास्टिक के  परिवर्तित एवं पुनश्चक्रित रूप से प्राप्त महीन पाउडर को _________ कहा जाता है।
Ans 1. पॉलीस्टाइरीन

2. पॉलीथीन

3. पॉलीएथिलीन

4. पॉलीब्लेंड

Q.35 झूम कृ षि की पद्धति _______________ में प्रचलित है।
Ans 1. उत्तर पश्चिम

2. दक्षिण पूर्व

3. उत्तर पूर्व

4. दक्षिण पश्चिम

Q.36 भारतीय राष्ट्री य आंदोलन के  दौरान चरमपंथियों  का मुख्य उद्देश्य क्या था?
Ans 1. पूर्ण स्वतंत्रता (स्वराज) प्राप्त करना

2. सामाजिक सुधार लाना

3. विधान परिषदों का विस्तार करना

4. भारत में ब्रिटिश वस्तुओं को बढ़ावा देना

Q.37 निम्नलिखित में से कौन-सा कथन उचित प्रकार से व्यख्या करता है कि तेज पवन वाले दिन (windy day)
में कपड़े तेजी से क्यों सूखते हैं?

Ans 1. पवन कपड़ों के  आस-पास से जलवाष्प को हटाती है।

2. पवन कपड़ों के  आस-पास की नमी को बढ़ाती है।

3. पवन जल के  अणुओं के  ताप को कम करती है।

4. पवन कपड़ों के  पृष्ठ क्षेत्र को कम करती है।
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Q.38 फरवरी 2025 में, निम्नलिखित में से किस कं पनी द्वारा विश्व की सबसे लंबी समुद्री के बल बनाने की योजना
की घोषणा की गई, जिसका लक्ष्य भारत में लैंडिंग पॉइंट के  साथ पांच महाद्वीपों  में इंटरनेट कनेक्टिविटी
को बढ़ाना है?

Ans 1. माइक्रोसॉफ्ट

2. गूगल

3. अमेज़ॅन

4. मेटा

Q.39 मधुमक्खी के  डंक से दर्द और जलन क्यों होता है?
Ans 1. डंक एक हल्के  शर्क रा विलयन को इंजेक्ट करता है।

2. डंक मेथनोइक अम्ल को इंजेक्ट करता है।

3. डंक में एक प्रबल क्षार होता है।

4. डंक कार्बन डाइऑक्साइड गैस मुक्त करता है।

Q.40 गुप्त प्रशासन में कौन-सा अधिकारी, शांति एवं युद्ध मामलों  के  लिए उत्तरदायी था?
Ans 1. विषयपति

2. महादंडनायक

3. महाप्रतिहार

4. संधि-विग्रहिका

Q.41 निम्नलिखित में से कौन-सा, CPU का एक कॉम्पोनेंट नहीं  है?
Ans 1. कै श मेमोरी (Cache Memory)

2. हार्ड डिस्क (Hard Disk)

3. कं ट्रो ल यूनिट (Control Unit - CU)

4. अरिथमेटिक लॉजिक यूनिट (Arithmetic Logic Unit - ALU)

Q.42 The primary agent that helps in the decomposition of biodegradable matter in domestic
sewage is __________.

Ans 1. chloride

2. bacterium

3. nitrate

4. phosphate

Q.43 स्प्रेडशीट में नया कॉलम इन्सर्ट करने का सही तरीका निम्नलिखित में से कौन-सा है?
Ans 1. File पर जाए > New > Column

2. Home पर जाए > Insert > Sheet Column इन्सर्ट करें

3. कॉलम इन्सर्ट करने के  लिए Ctrl + Z का उपयोग करें

4. Ctrl + X दबाएँ  और फिर Insert करें

Q.44 यदि किसी माध्यम का निरपेक्ष अपवर्तनांक 1 से कम है, तो इसका अर्थ है, ________।
Ans 1. प्रकाश उस माध्यम में निर्वात की तुलना में धीमी गति से यात्रा करता है

2. माध्यम समस्त प्रकाश को अवशोषित करता है

3. माध्यम एक पूर्ण परावर्तक है

4. प्रकाश उस माध्यम में निर्वात की तुलना में अधिक तेजी से यात्रा करता है

Q.45 निम्नलिखित में से किस क्षेत्र में हिमालय की चौड़ाई सर्वाधिक है?
Ans 1. कश्मीर

2. हिमाचल प्रदेश

3. अरुणाचल प्रदेश

4. सिक्किम
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Q.46 ग्रीनहाउस में उपयोग किया जाने वाला ग्लास पैनल ____________ को धारण रखने के  लिए जाना जाता
है।

Ans 1. वर्षा

2. आर्द्रता

3. ऊष्मा

4. pH

Q.47 PCB का पूर्ण रूप क्या है?
Ans 1. Printed Circuit Board (प्रिंटेड सर्कि ट बोर्ड)

2. Processing Circuit Board (प्रोसेसिंग सर्कि ट बोर्ड)

3. Peripheral Connection Bus (पेरिफे रल कनेक्शन बस)

4. Primary Control Board (प्राइमरी कं ट्रो ल बोर्ड)

Q.48 जड़त्व किसी वस्तु के  किस गुणधर्म पर निर्भर करता है?
Ans 1. आकृ ति

2. त्वरण

3. वेग

4. द्रव्यमान

Q.49 पर्सनल कं प्यूटर पर फ़ायरवॉल (firewall) का उपयोग करने का मुख्य उद्देश्य क्या है?
Ans 1. स्टोरेज स्पेस बढ़ाना

2. टेम्पररी फ़ाइलों को क्लीन अप करना

3. इंटरनेट कनेक्टिविटी को तेज़ करना

4. अनधिकृ त एक्सेस को ब्लॉक करना और कं प्यूटर को प्रोटेक्ट करना

Q.50 निम्नलिखित में से कौन-सा राज्य, अटल भूजल योजना के  अंतर्गत नहीं  आता है?
Ans 1. महाराष्ट्र

2. राजस्थान

3. झारखंड

4. उत्तर प्रदेश

Q.1 निम्नलिखित में से कौन-सा कारक, पृष्ठीय अपवाह को संभवतः  कम करेगा?
Ans 1. उच्च तीव्रता वाली वर्षा

2. पारगम्य मृदा और वनस्पति आवरण

3. सड़कों और इमारतों जैसे अप्रवेश्य पृष्ठ

4. वनस्पति का हटाया जाना

Q.2 संसंजक मृदा को संहत करने के  लिए किस प्रकार का रोलर सबसे उपयुक्त है?
Ans 1. शीप फु ट रोलर (Sheep foot roller)

2. न्‍यूमेटिक रोलर (Pneumatic roller)

3. स्मूथ व्हील रोलर (Smooth wheel roller)

4. वाइब्रेटरी रोलर (Vibratory roller)

Q.3 दाबदर्शी शीर्ष (manometric head) के  संबंध में निम्नलिखित में से कौन-सा कथन सही है?
Ans 1. इसमें घर्षण हानि शामिल नहीं  हैं।

2. यह के वल पंप के  चूषण शीर्ष (suction head) को निरूपित करता है।

3. यह सभी पंपों के  लिए एक अचर मान है।

4. यह प्रभावी शीर्ष है जो हानियों का लेखा रखता है।

Section : Technical Abilities
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Q.4 बल आघूर्ण किन कारकों  पर निर्भर करता है?
Ans 1. घूर्णन की चाल

2. के वल घूर्णन बिंदु से दू री

3. बल परिमाण और लंबवत दू री दोनों

4. के वल बल के  परिमाण

Q.5 टीप (Pointing) एक प्रक्रिया है जो __________ में की जाती है।
Ans 1. पलस्तर वाली दीवारों

2. वैटल और मृदा से लेपित दीवारों

3. प्लास्टर की हुई चिनाई वाली दीवारों

4. खुली चिनाई वाली दीवारों

Q.6 प्रत्यास्थता गुणांक (E) और अपरूपण गुणांक (G) के  मध्य सही संबंध निम्नलिखित में से किसके  द्वारा दिया
जाता है?

Ans 1. E = 3G(1−2μ)

2. E = G(1+2μ)

3. E = 2G(1+μ)

4. E = G(1+μ)

Q.7 ठोस शंकु  का गुरुत्व के न्द्र कहाँ स्थित होता है?
Ans

1. अक्ष के  अनुदिश आधार से  ऊँ चाई पर

2. आधार के  ज्यामितीय कें द्र पर

3. अक्ष के  अनुदिश आधार से​​​​​​​  ऊँ चाई पर

4. शंकु  के  शीर्ष पर

Q.8 चित्र तल (picture plane) पर वह बिंदु  जहाँ सभी समांतर रेखाएँ  मिलती हुई प्रतीत होती हैं, ________
कहलाता है।

Ans 1. लोपी बिंदु (vanishing point)

2. नेत्र स्तर बिंदु (eye level point)

3. दृष्टि कोण बिंदु (angle of vision point)

4. प्रेक्षण बिंदु (station point)

Q.9 राजमार्ग कु ट्टिमों  में अधः  स्तर मृदा (subgrade soil) के  लिए उचित जल निकास क्यों आवश्यक है?
Ans 1. सीमेंट के  साथ आसानी से मिश्रित करने देने के  लिए

2. नमी प्रतिधारण और सामर्थ्य में कमी को रोकने के  लिए

3. अपरदन को कम करने के  लिए

4. मृदा के  तापमान को बढ़ाने के  लिए

Q.10 भारतीय सुदू र संवेदन (Indian Remote Sensing) उपग्रहों  पर लगा निम्नलिखित में से कौन-सा सेंसर,
जंगल की आग जैसी गतिक परिघटना को मॉनिटर करने में सक्षम है?

Ans 1. WiFS

2. MOS

3. LISS I

4. PAN
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Q.11 यदि किसी आयताकार खांच (notch) की चौड़ाई दोगुनी कर दी जाए, तो निस्सरण
________________।

Ans 1. दोगुना हो जाएगा

2. समान रहेगा

3. आधा हो जाएगा

4. तीन गुना बढ़ जाएगा

Q.12 बोरोसिलिके ट ग्लास (Borosilicate glass) का उपयोग निम्नलिखित में से किस गुण के  कारण
प्रयोगशाला उपकरण और खाना पकाने के  बर्तनों  के  निर्माण में किया जाता है?

Ans 1. यह एक प्रबल ग्लास है और भंग (breakage) का प्रतिरोध करता है।

2. यह उच्च ताप को सहन कर सकता है।

3. यह एक पारदर्शी ग्‍लास है और विजन (vision) को अस्पष्ट नहीं  करता है।

4. इसे घुमावदार आकृ तियों में ढाला जा सकता है।

Q.13 डार्सी के  नियम के  अनुसार, मृदा प्रवाह संबंधी समस्याओं के  लिए निम्नलिखित में से किस दाबोच्चता की
उपेक्षा की जाती है?

Ans 1. दाबीय दाबोच्चता (Pressure head)

2. वेग दाबोच्चता (Velocity head)

3. स्थितिज दाबोच्चता (Datum head)

4. द्रवीय दाबोच्चता (Hydraulic head)

Q.14 गहरी नीं व में पाइल कै प (pile cap) का प्राथमिक कार्य क्या है?
Ans 1. पाइल की लंबाई कम करना

2. सौन्दर्यपरक स्वरूप में सुधार करना

3. सभी पाइल के  बीच लोड को समान रूप से वितरित करना

4. नीं व में जल प्रवेश को रोकना

Q.15 उथली नीं व (shallow foundation) के  लिए कौन-सी मृदा सबसे कम उपयुक्त है?

Ans 1. गाद मृत्तिका
2. काली कपास मृदा
3. मोटी रेत
4. बारीक रेत

Q.16 निम्नलिखित में से कौन-सी, एक अच्छी फरमाबंदी की अभीष्‍ट विशेषता नहीं  है?
Ans 1. आसानी से संभाला और हटाया जाना

2. एक मसृण पृष्‍ठ फिनिश प्रदान करना

3. दृढ़ और मजबूत होना

4. अतिरिक्त पानी को अवशोषित करने के  लिए अत्यधिक अवशोषक होना

Q.17 सुरंग निर्माण और सैन्य अनुप्रयोगों  में प्रयुक्त विस्फोटक PENT या PETN का पूर्ण रूप निम्नलिखित में से
कौन-सा है?

Ans 1. Pyrotechnic Explosive Nitrogen Trigger (पाइरोटेक्निक एक्सप्लोसिव नाइट्रो जन ट्रि गर)

2. Pentaerythritol Tetranitrate (पेन्टाएरिथ्रिटॉल टेट्रा नाइट्रे ट)

3. Polyethylene Nitrogen Trinitrate (पॉलिएथिलीन नाइट्रो जन ट्रा इनाइट्रे ट)

4. Pentane Energy Nitrate (पेन्टेन एनर्जी नाइट्रे ट)
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Q.18 एकल प्रबलित बीम में, सुदृढ़ीकरण किस क्षेत्र में प्रदान किया जाता है?
Ans 1. के वल संपीडन क्षेत्र

2. तनन और संपीडन दोनों क्षेत्र

3. के वल तनन क्षेत्र

4. संपूर्ण अनुप्रस्थ-परिच्‍छे द

Q.19 लिंटल (lintel) किस प्राथमिक भार का प्रतिरोध करता है?
Ans 1. बंकन भार (Bending load)

2. अक्षीय भार (Axial load)

3. पार्श्‍विक भार (Lateral load)

4. कतरनी भार (Shear load)

Q.20 3ds Max में वायरफ्रे म मोड को टॉगल (toggle) करने के  लिए किस कीबोर्ड शॉर्टकट का उपयोग किया
जाता है?

Ans 1. W

2. Ctrl + W

3. F3

4. Shift + X

Q.21 Which of the following statements is true regarding a fixed beam?
Ans 1. The deflection and slope at the fixed end are zero.

2. A fixed beam does not experience end moments

3. A fixed beam is always supported on more than two supports.

4. The deflection at the fixed ends is zero, but the slope is not zero.

Q.22 RCC (M20 ग्रेड) के  लिए सीमेंट, रेत और मिलावा का विशिष्ट अनुपात कितना होता है?
Ans 1. 1 : 1.5 : 3

2. 1 : 4 : 8

3. 1 : 3 : 6

4. 1 : 2 : 3

Q.23 निम्नलिखित में से कौन-सा, इंजीनियरी पैमाने को निरूपित करता है?
Ans 1. 1 in 10

2. 1 cm = 10 m

3. 2%

4. 1/5000

Q.24 Which type of reinforcement is called the main reinforcement in a one-way slab?
Ans 1. Bottom reinforcement provided in the shorter span direction

2. Top reinforcement provided in the transverse direction

3. Bottom reinforcement placed in the longer span direction

4. Top reinforcement supported along the longer span
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Q.25 लंबाई 'L' और अनुप्रस्थ-काट क्षेत्रफल 'A' वाली एक प्रिज्मीय छड़ पर अक्षीय तनन लोड 'P' लगाया जाता
है। छड़ में प्रेरित अधिकतम प्रतिबल कितना है?

Ans
1. 

           

2. 

3. 

           

4. 

            

Q.26 सेतु का निम्नलिखित में से कौन-सा संरचनात्मक अवयव सीधे अधिरचना को आधार प्रदान करता है और
भार को नीं व में स्थानांतरित करता है?

Ans 1. प्रसार जोड़ (Expansion Joints)

2. डेक (Deck)

3. पियर्स (Piers)

4. बेयरिंग्स (Bearings)

Q.27 नए टीप (pointing) कार्य के  लिए पृष्ठ के  निर्माण का सही क्रम इनमें से कौन-सा है?
Ans 1. पृष्ठ और जोड़ों को गीला करना; जोड़ों को रेक करना; पृष्ठ और जोड़ों को साफ करना

2. जोड़ों को रेक करना; पृष्ठ और जोड़ों को साफ करना; पृष्ठ और जोड़ों को गीला करना

3. पृष्ठ और जोड़ों को साफ करना; पृष्ठ और जोड़ों को गीला करना; जोड़ों को रेक करना

4. पृष्ठ और जोड़ों को साफ करना; जोड़ों को रेक करना; पृष्ठ और जोड़ों को गीला करना

Q.28 अवस्‍थापन प्‍लान (Location Plan) को _______भी कहा जाता है।
Ans 1. सर्वे प्‍लान (Survey Plan)

2. साइट प्‍लान (Site Plan)

3. मास्‍टर प्‍लान (Master Plan)

4. मुख्य प्‍लान (Key Plan)

Q.29 भारवाही दीवार (load-bearing walls) के  लिए सबसे सुदृढ़ और सबसे उपयुक्त, निम्नलिखित में से कौन-
सा बॉन्‍ड माना जाता है?

Ans 1. स्ट्रे चर बॉन्‍ड (Stretcher bond)

2. हेडर बॉन्‍ड (Header bond)

3. फ्लेमिश बॉन्‍ड (Flemish bond)

4. इंग्लिश बॉन्‍ड (English bond)

Q.30 अधिक महीन एग्रीगेट मिलाने से रेडी मिक्स कं क्रीट (RMC) के  गुणों  पर क्या प्रभाव पड़ता है?
Ans 1. सुकार्यता बढ़ जाती है

2. प्रत्यक्ष रूप से संपीडन सामर्थ्य में सुधार होता है

3. हिमन और हिमद्रवण के  प्रति प्रतिरोध बढ़ जाता है

4. दृढ़ीकरण काल बढ़ जाता है

Q.31 विस्तारित पॉलिस्टाइरीन (EPS) का उपयोग प्रायः  निम्नलिखित में से किसके  निर्माण में किया जाता है?
Ans 1. ऊष्मारोधन पैनल

2. संरचनात्मक इस्पात

3. प्रबलित कं क्रीट

4. विद्यु त वायरिंग
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Q.32 यदि लंबाई 'L' के  एक कै न्‍टीलीवर बीम पर इसकी संपूर्ण लंबाई पर एकसमान रूप से वितरित लोड
(UDL), w (kN/m) लगाया जाता है, तो स्थिर छोर पर बंकन आघूर्ण कितना है?

Ans
1. 

            
            

2. 

           

3. 

           
           

4. 

           
           

Q.33 शब्द 'एक्सेंट्रि क फ़ु टिंग (eccentric footing)', ____________ पाद को संदर्भित करता है।
Ans 1. स्तंभ के  सापेक्ष कें द्र से दू र रखे गए

2. मशीन फ़ाउंडेशन के  लिए उपयोग किए जाने वाले

3. एकाधिक स्तंभों द्वारा साझा किए गए

4. वृत्तीय आकार वाले

Q.34 किसी स्तंभ का एक छोर स्थिर तथा दू सरा छोर कब्जेदार (hinged) है, तो प्रभावी लंबाई कारक K कितना
होगा?

Ans 1. 0.5

2. 1.0

3. 0.7

4. 2.0

Q.35 नाली खपरा (Half round country tiles), _________ के  युग्म में बिछाए जाते हैं।
Ans 1. बॉटम टाइल और क्राउन टाइल

2. बेस टाइल और कवरिंग टाइल

3. लैप टाइल और ओवरलैप टाइल

4. अंडर टाइल और ओवर टाइल

Q.36 यदि प्रतिधारक भित्‍ति (retaining wall), पश्‍च भरण (backfill) से दू र चली जाती है, तो रैं किन के  मृदा
दाब गुणांक का मान किस प्रकार ज्ञात किया जाता है?

Ans
1. 

2. (1 − sin φ)

3. 

4. (1 + sin φ)

Q.37 बिल्डिंग सेक्शन ड्रा इंग (building section drawing) निम्नलिखित में से कौन-सी जानकारी नहीं  देती है?
Ans 1. संरचना के  लिए प्रयुक्त सामग्री का प्रकार

2. कमरों की लंबाई और चौड़ाई

3. संरचना के  लिए प्रयुक्त नीं व

4. संरचना की ऊं चाई
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Q.38 रैफ्ट नीं व (raft foundation) का मुख्य लाभ कौन-सा है?
Ans 1. निषदन (Settlement) एकसमान

2. अन्य नीं वों की तुलना में सस्ता

3. निर्माण (construct) करना आसान

4. कॉलम स्पेसिंग (column spacing) कम करना

Q.39 IS 10262:2009 के  अनुसार, 25 से 50 mm की अवसर्प परिसर पर विचार करते हुए, 20 mm अभिहित
अधिकतम आकार कोणीय स्थूल समुच्चय के  लिए कं क्रीट की प्रति इकाई मात्रा में अधिकतम मिश्रण
जलांश कितना है?

Ans 1. 200 kg/m3

2. 186 kg/m3

3. 250 kg/m3

4. 150 kg/m3

Q.40 उत्खनन के  दौरान सख्त पृष्ठों  को तोड़ने के  लिए किस उपकरण का उपयोग किया जाता है?
Ans 1. फावड़ा

2. सब्बल

3. कु दाली

4. रेक

Q.41 संविदा की सामान्य शर्तों के  अनुसार, ठे के दार द्वारा जमा की जाने वाली प्रतिभूति धनराशि (security
money) _____________ होती है।

Ans 1. प्राक्कलित लागत का 5%

2. प्राक्कलित लागत का 10%

3. प्राक्कलित लागत का 20%

4. प्राक्कलित लागत का 2%

Q.42 Which of the following environmental factors negatively affects the durability of
concrete?

Ans 1. Dry conditions with proper curing done

2. Well-ventilated surroundings

3. Stable temperature with no moisture changes

4. High temperature and humidity variations

Q.43 वर्षण दर के  अंतः स्यंदन दर से अधिक होने पर क्या होता है?
Ans 1. वाष्पन पूरी तरह से रुक जाता है

2. पृष्ठीय अपवाह बढ़ता है

3. भूजल पुनर्भरण होता है

4. नदियाँ और झीलें शीघ्रता से वाष्पित होने लगती हैं

Q.44 संरचनात्मक दरारों  के  संबंध में निम्नलिखित में से कौन-सा कथन सत्य नहीं  है?
Ans 1. संरचनात्मक घटकों के  अतिभार के  कारण होता है।

2. भवन निर्माण सामग्री पर नमी आदि में परिवर्तन के  कारण होता है।

3. सामान्यतः  क्षति को सुधारना या मरम्मत करना कठिन होता है।

4. भवन के  स्थायित्व के  लिए महत्वपूर्ण जोखिम उत्पन्न करते हैं।
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Q.45 ट्रै  फ़िक मार्किं ग (traffic marking) वर्गीकरण के  संबंध में निम्नलिखित में से कौन-सा कथन गलत है?
Ans 1. अनुप्रस्थ मार्किं ग में स्टॉप लाइन, पैदल यात्री क्रॉसिंग और यील्ड लाइन शामिल होती हैं।

2. पीली मार्किं ग का उपयोग विशेष रूप से नियामक उद्देश्यों के  लिए किया जाता है, जबकि सफे द मार्किं ग का उपयोग के वल मार्गदर्शन के  लिए किया
जाता है।

3. ऑब्जेक्ट मार्किं ग का उपयोग, सड़क के  किनारे  स्थित स्थिर अवरोधों जैसे कि मीडियन और पुल के  खंभों को इंगित करने के  लिए किया जाता है।

4. अनुदैर्ध्य मार्किं ग, लेन अनुशासन को नियमित करती है और ड्रा इवरों को मार्गदर्शन प्रदान करती है।

Q.46 भारी वर्षा वाले क्षेत्रों  के  लिए किस प्रकार की खिड़की की सिल (window sill) सबसे उपयुक्त है?
Ans 1. ढलानदार सिल (Sloped sill)

2. सपाट सिल (Flat sill)

3. ऊर्ध्वाधर सिल (Vertical sill)

4. क्षैतिज सिल (Horizontal sill)

Q.47 मृदा तीन परतों  से बनती है, जिनमें से प्रत्येक की ऊँ चाई 'h' मीटर है। परतों  की पारगम्यता क्रमशः  k, 2k
और k है। ऊर्ध्वाधर दिशा में समतुल्य पारगम्यता ज्ञात कीजिए।

Ans 1. 6k/5

2. 2k/5

3. 4k

4. 5/2k

Q.48 भारत में निम्नलिखित में से किस राज्य में पवन ऊर्जा की अधिकतम क्षमता है?
Ans 1. उत्तर प्रदेश

2. गुजरात

3. पंजाब

4. हिमाचल प्रदेश

Q.49 सूक्ष्मकणिक मृदा में जल स्तर कम होने के  कारण नीं व निषदन ___________ कहलाता है।
Ans 1. संघनन (consolidation)

2. अपरदन (erosion)

3. प्लास्टिक संपीडन (plastic compression)

4. प्रत्यास्थ संपीडन (elastic compression)

Q.50 जब किसी स्‍तंभ को प्रॉपर्टी बाउंड्री  के  पास रखा जाता है, तो एक तरफ फु टिंग विस्तार को प्रतिबंधित
करते हुए किस प्रकार के  फु टिंग का सबसे अधिक उपयोग किया जाता है?

Ans 1. स्ट्रै प फु टिंग (Strap footing)

2. कम्‍बाइंड फु टिंग (Combined footing)

3. मैट फु टिंग (Mat footing)

4. आइसोलेटेड फु टिंग (Isolated footing)

Q.51 आवास की योजना बनाते समय, क्या सुनिश्चित करने के  लिए अभिविन्यास के  सिद्धांत को अपनाया जाता
है?

Ans 1. आवास में उचित स्वच्छता और साफ-सफाई सुनिश्चित करना

2. आवश्यक गोपनीयता प्राप्त करने के  लिए कमरों के  अभिविन्यस्त को सुनिश्चित करना

3. डिजाइन में प्राकृ तिक तत्वों का प्रभावी ढंग से उपयोग किए जाने को सुनिश्चित करना

4. आवास के  सुंदर सौंदर्यपरक स्वरूप को सुनिश्चित करना

Q.52 क्षैतिज वक्र पर ग्रेड क्षतिपूर्ति (grade compensation) लागू करने का मुख्य उद्देश्य क्या है?
Ans 1. सड़क के  पृष्‍ठ को सपाट बनाना

2. वाहनों के  संकर्षी बल (tractive effort) को बढ़ाना

3. वक्र और प्रवणता के  कारण होने वाले घर्षणी प्रतिरोध को कम करना

4. वाहनों को वक्रों पर उच्चतर चाल से यात्रा करने की अनुमति देना
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Q.53 निम्नलिखित में से कौन-सा, ड्रि लिंग उपस्कर का एक प्रकार नहीं  है?
Ans 1. जैक हैमर (Jack hammer)

2. ट्र क माउंटेड ड्रि ल (Truck mounted drill)

3. एस्के वेटर (Excavator)

4. ड्रि फ्टर (Drifters)

Q.54 एक रेखा का पूर्ण वृत्तीय दिक्मान और समानीत दिक्मान तब समान होगा, जब रेखा ________ चतुर्थांश
में होगी।

Ans 1. दक्षिण-पश्चिम

2. उत्तर-पूर्व

3. उत्तर-पश्चिम

4. दक्षिण-पूर्व

Q.55 कं क्रीट में स्टील फाइबर मिलाने का मुख्य उद्देश्य क्या है?
Ans 1. कं क्रीट का भार बढ़ाना

2. सीमेंट की आवश्यकता को कम करना

3. इसके  तनन सामथर्य और दरार प्रतिरोध (crack resistance) में सुधार करना

4. जल सीमेंट अनुपात को बढ़ाना

Q.56 निम्नलिखित में से कौन-सा, स्लेट टाइल छत (slate tile roofing) के  लिए कच्चे माल के  रूप में उपयोग
किया जाता है।

Ans 1. भूसा (straw)

2. धातु (metal)

3. पत्थर (stone)

4. पंक (mud)

Q.57 जल की टंकियों  के  प्राक्कलन के  संबंध में निम्नलिखित में से कौन-सा कथन सही है?

A: जल की टंकी की दीवारों  के  प्लास्टर में जलरोधी यौगिक मिलाए जाते हैं।
B: जल की टंकियों  के  प्राक्कलन के  मद विवरण में, इसके  परितः  बनाई जाने वाली सीढ़ी का प्राक्कलन
शामिल नहीं  है।
C: जब की टंकियों  की ऊर्ध्वाधर और क्षैतिज दीवारें  मिलती हैं, तो उनके  प्रतिच्छे दन पर एक ढलवां संरचना
का निर्माण होता है, इसे हॉंचिंग (haunching) कहा जाता है।
D: जब की टंकियों  की ऊर्ध्वाधर और क्षैतिज दीवारें  मिलती हैं, तो उनके  प्रतिच्छे दन पर एक ढलवां संरचना
का निर्माण होता है, इसे सोलिंग (soling) कहा जाता है।

Ans 1. A और C

2. B और C

3. A और D

4. B और D

Q.58 एक प्रबलित कं क्रीट बीम में, IS 456:2000 के  अनुसार पर्याप्त अपरूपण प्रबलन सुनिश्चित करने के  लिए,
प्रभावी गभीरता के  संदर्भ में ऊर्ध्वाधर वलयकों (vertical stirrups) में अंतराल कितना होना चाहिए?

Ans 1. यह बीम की प्रभावी गभीरता (d) से अधिक नहीं  होना चाहिए।

2. यह बीम की प्रभावी गभीरता (d) के  दोगुने से अधिक नहीं  होना चाहिए।

3. यह बीम की प्रभावी गभीरता (d) से 0.75 गुना अधिक नहीं  होना चाहिए।

4. यह बीम की प्रभावी गभीरता (d) से 1.5 गुना अधिक नहीं  होना चाहिए।

Q.59 सौर ऊर्जा का उपयोग करने वाले युक्‍ति (डिवाइस) सामान्यतः  निम्नलिखित में से किससे कोटेड (coated)
होते हैं?

Ans 1. टाइटेनियम ऑक्साइड कोटिंग (titanium oxide coating)

2. एं टी-रिफ्लेक्टिव कोटिंग (anti-reflective coating)

3. एं टी-ग्लेयर कोटिंग (anti-glare coating)

4. कार्बाइड कोटिंग (carbide coating)
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Q.60 भारतीय रेलवे में कं क्रीट स्लीपरों  के  साथ समान्यतः  किस बंधन तंत्र (fastening system) का उपयोग
किया जाता है?

Ans 1. फिश प्लेट (Fish Plate)

2. डॉग स्पाइक (Dog Spike)

3. इलास्टिक रेल क्लिप (Elastic Rail Clip)

4. फैं ग बोल्ट (Fang Bolt)

Q.61 एस्के लेटर बालूस्ट्रेड (Escalator balustrades) मुख्य रूप से ________ के  लिए डिज़ाइन किए गए हैं।
Ans 1. सौंदर्यपरकता में सुधार करने

2. कं ट्रो ल पैनल को फिट करने

3. सीढ़ियों के  भार को आलंब प्रदान करने

4. उपयोगकर्ताओं को गिरने से बचाने

Q.62 निम्नलिखित में से कौन-सा, जल स्तर में उच्चावचलन के  कारण नीं व के  निषदन का कारण बनता है?
Ans 1. विस्फोट के  कारण कं पन

2. प्रसारित मृदा की मौसमी स्फीति और संकु चन

3. ढलान वाले स्थानों पर भूमि स्तर का सर्पण।

4. निकटवर्ती उत्खनन

Q.63 What is the role of impact force in the soil compaction process?
Ans 1. It helps to retain moisture.

2. It creates a uniform soil texture.

3. It reduces the void spaces by sudden compression.

4. It increases soil permeability.

Q.64 फर्श की मात्रा________________________________।
Ans 1. m3 में मापी जाती है और लंबाई, चौड़ाई तथा ऊं चाई को अधिरचना की दीवार से दीवार तक आंतरिक आयामों के  रूप में लिया जाता है

2. m3 में मापी जाती है और लंबाई, चौड़ाई तथा ऊं चाई को अधिरचना की दीवार से दीवार तक बाह्य आयामों के  रूप में लिया जाता है

3. m2 में मापी जाती है और लंबाई तथा चौड़ाई को अधिरचना की दीवार से दीवार तक आंतरिक आयामों के  रूप में लिया जाता है

4. m2 में मापी जाती है और लंबाई तथा चौड़ाई को अधिरचना की दीवार से दीवार तक बाह्य आयामों के  रूप में लिया जाता है

Q.65 IS 2386 भाग IV, 1963 के  अनुसार, रनवे, सड़कों और फु टपाथ जैसे निघर्षक पृष्‍ठों  हेतु कं क्रीट के  लिए
समुच्चय संदलन मान _______ से अधिक नहीं  होना चाहिए।

Ans 1. 50%

2. 45%

3. 35%

4. 30%

Q.66 क्ष‍त कं क्रीट (damage concrete) क्षेत्रों  की मरम्मत के  लिए होज़ पाइप और नोजल के  साथ दाब के  तहत
कं क्रीट को शूट करना (Shooting) ______________ कहलाता है।

Ans 1. सीलिंग (sealing)

2. क्योरिंग (curing)

3. गनाइटीकरण (guniting)

4. कं क्रीटन (concreting)

Q.67 ऑटोडेस्क 3ds मैक्स (Autodesk 3ds Max) में नया सीन (scene) क्रिएट करने के  लिए निम्नलिखित में
से किस कमांड का उपयोग किया जाता है?

Ans 1. File -> New

2. Edit -> New Scene

3. Create -> Scene Setup

4. File -> Open
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Q.68 ऊँ ची इमारतों  में कं क्रीट बिछाने के  लिए सबसे अधिक किस विधि का उपयोग किया जाता है?
Ans 1. पंपिंग विधि से

2. बिना किसी नियंत्रण के  ऊं चाई से कं क्रीट डालना

3. व्हीलबैरो का उपयोग करके  सीधे बिछाना

4. हाथ से मिलाना और बिछाना

Q.69 वनस्पति के  कारण भवनों  में उत्‍पन्‍न दरारें  निम्नलिखित में से किस कारण से होती हैं?
Ans 1. वनस्पतियों को हटाने से उत्पन्न शुष्क परिस्थितियों

2. भवन के  बहुत निकट पेड़ों की जड़ों

3. भवन के  आस-पास पेड़ों की घनी शाखाओं

4. वनस्पति के  वाष्पोत्सर्जन के  कारण नमी

Q.70 प्रत्यागामी पंप में, निम्न में से कौन-सा विकल्प पिस्टन को क्रैं कशाफ्ट (crankshaft) से जोड़ता है?
Ans 1. चूषण पाइप

2. बेयरिंग

3. निकास पाइप

4. संयोजी छड़

Q.71 वेल्लित प्लेटों  (rolled plates) का उपयोग करके  संविरचित (fabricated) बीमों  को क्या कहा जाता है?
Ans 1. प्लेट गर्डर (Plate girder)

2. हाइब्रिड बीम (Hybrid beam)

3. कै स्टेलेटेड बीम (Castellated beam)

4. कम्पोजिट बीम (Composite beam)

Q.72 ग्रेनाइट, बेसाल्ट, क्वार्टजाइट आदि जैसे अत्यधिक कठोर और सख्त गुण वाले मोटे एग्रीगेट से बने बहु
सीमेंट कं क्रीट की परिसज्जा को _____ परिसज्जा के  रूप में जाना जाता है।

Ans 1. मोनोलिथिक (monolithic)

2. सिरे मिक (ceramic)

3. टेराज़ो (terrazzo)

4. ग्रेनोलिथिक (granolithic)

Q.73 एक लाइट के  खंभे को तीन तनावित के बलों  (tensioned cables) द्वारा एक सामान्य बिंदु  पर एक-दू सरे
के  साथ 60°, 75° और 45° के  कोण बनाते हुए रखा जाता है। साम्यावस्था मानते हुए, कौन-सा प्रमेय
के बलों  में तनाव निर्धारित करने में सहायता करता है?

Ans 1. वैरिग्नन का प्रमेय (Varignon’s theorem)

2. समांतर अक्ष प्रमेय (Parallel axis theorem)

3. न्यूटन का द्वितीय नियम (Newton’s second law)

4. लामी का प्रमेय (Lami’s theorem)

Q.74 निम्नलिखित में से कौन-सा, बायोगैस का एक मुख्य दहनशील घटक है?
Ans 1. मेथेन

2. ब्यूटेन

3. हाइड्रो जन सल्फाइड

4. कार्बन डाइऑक्साइड

https://www.adda247.com/?srsltid=AfmBOorxWlJHJat0hxykMSj0dTevsfMXFCCKkF-M1iJl0fZs38MiR7HD
https://play.google.com/store/apps/details?_gl=1%2Amx0b1g%2A_gcl_au%2AMTY5Nzk3MzE3LjE3NDQwMzIyMTI.&gl=US&hl=en_IN&id=com.adda247.app&pli=1


Q.75 उस युग्म का चयन कीजिए, जिसमें शब्द एक दू सरे  से उसी प्रकार का संबंध प्रस्तुत करते हैं जैसा कि दिए
गए युग्म के  शब्द करते हैं।

अनुमानित मात्रा प्राक्कलन : रनिंग मीटर लंबाई : : घन दर प्राक्कलन : ____________
Ans 1. घनीय सामग्री (cubical content)

2. एक कमरे  की लागत (cost of one room)

3. क्षेत्रफल सामग्री (area content)

4. प्लिंथ क्षेत्रफल (plinth area)

Q.76 यदि दीवार की लंबाई, चौड़ाई और ऊं चाई क्रमशः  7 m, 0.3 m, 3 m है, तो ईंट चिनाई (brickwork) की
कु ल आवश्यक मात्रा कितनी होगी?

Ans 1. 6.3 m3

2. 12.6 m3

3. 21 m2

4. 0.9 m2

Q.77 Which type of scaffolding is used for painting tall buildings?
Ans 1. Cantilever scaffolding

2. Suspended scaffolding

3. Double scaffolding

4. Single scaffolding

Q.78 निम्नलिखित में से किस उपाय के  उपयोग से सल्फे ट के  हमले (sulphate attack) के  परिणामस्वरूप होने
वाली दरारों  को नहीं  रोका जा सकता है?

Ans 1. निर्माण कार्यों में समृद्ध सीमेंट मोर्टार या कं क्रीट का उपयोग

2. शुष्क परिस्थितियों को बनाए रखने के  लिए आर्द्ररोधी का प्रावधान

3. निर्माण कार्यों में सल्फे ट प्रतिरोधी सीमेंट का उपयोग

4. विलेय लवणों के  उच्च प्रतिशत वाली ईंटों का उपयोग

Q.79 पार्टिकल बोर्ड (particle board) निम्नलिखित में से किससे बना होता है?

Ans 1. दो पृष्‍ठावरण (veneers) के  बीच चिपकी हुई पतले काष्ठ की पट्टियों से

2. ऊष्मा/दाब के  अधीन दबाए गए बंधक (binder) में काष्ठ कणों से

3. दाब के  अधीन चिपकाई गई विषम संख्या में पृष्‍ठावरण की परतों से

4. एक साथ ढाले गए काष्ठ रेशे और संश्लेषित रे जिन से

Q.80 टेरज़ाघी के  धारण क्षमता सिद्धांत के  अनुसार, रै खिक अपरूपण के  रैं किन निष्क्रिय क्षेत्रों  (Rankines
passive zones) के  अपरूपण पात तलों  का कोण, क्षैतिज के  अनुदिश _____________ होता है। (जहाँ
φ = आंतरिक घर्षण कोण है)

Ans 1. 45 − φ/2

2. 45

3. φ/2

4. 45 + φ/2

Q.81 The vertical downward movement of a structure's base is known as _____.
Ans 1. Deformation

2. Deflection

3. Depression

4. Settlement
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Q.82 ऑटोडेस्क 3ds मैक्स (Autodesk 3ds Max) में 'Layer Manager' का क्या कार्य है?
Ans 1. ऑब्जेक्ट दृश्यता को नियंत्रित करना और सीन ऑर्गनाइजेशन (scene organisation) को मैनेज करना

2. ऑब्जेक्ट को मटेरियल असाइन करना

3. सीन (scene) में कै मरे  एड करना

4. ऑब्जेक्ट्स को एक साथ ग्रुप करना

Q.83 आघूर्ण वितरण विधि में, किसी जोड़ पर संरचनात्मक अवयव के  लिए वितरण गुणक (DF) का निर्धारण
कै से किया जाता है?

Ans 1. किसी जोड़ पर विचारित अवयव की दुर्नम्यता को उस जोड़ पर मिलने वाले सभी अवयवों की कु ल दुर्नम्यता से जोड़कर

2. किसी जोड़ पर विचारित अवयव की दुर्नम्यता को उस जोड़ पर मिलने वाले सभी अवयवों की कु ल दुर्नम्यता से गुणा करके

3. किसी जोड़ पर विचारित अवयव की दुर्नम्यता को उस जोड़ पर मिलने वाले सभी अवयवों की कु ल दुर्नम्यता से विभाजित करके

4. एक जोड़ पर मिलने वाले सभी अवयवों की कु ल दुर्नम्यता को विचारित अवयव की दुर्नम्यता से विभाजित करके

Q.84 सर्वेक्षण का मूल सिद्धांत, 'संपूर्ण से भाग तक कार्य करना', निम्नलिखित में से किस विकल्प द्वारा सर्वोत्तम
रूप से निरूपित किया गया है?

Ans 1. यह सर्वेक्षण के  दू सरे  दिन काम जारी रखने में मदद करता है

2. यदि पहले एक परिशुद्ध मूल नियंत्रण स्थापित किया जाता है, तो बड़ी त्रुटियों को रोका जा सकता है और छोटी त्रुटियों को नियंत्रित एवं स्थानीयकृ त
किया जा सकता है।

3. सर्वेक्षण में आसानी

4. कोई भी व्यक्ति चंक्रम सर्वेक्षण को जल्दी से पूरा कर सकता है

Q.85 एक पंक्ति में निकट दू री वाले स्तंभों  के  लिए किस प्रकार के  पाद (footing) को प्राथमिकता दी जाती है?
Ans 1. पृथक पाद (Isolated footing)

2. संयुक्त पाद (Combined footing)

3. पट्टक पाद (Strap footing)

4. सतत पाद (Continuous footing)

Q.86 अपने कें द्र के  परितः  घूमने वाली L लम्बाई की एक पतली छड़ के  लिए, परिभ्रमण-त्रिज्या
.................................होती है?

Ans
1. 

            
2. 

3. 

           

4. 

           

Q.87 किस प्रकार की पत्थर की चिनाई में समान आकार और आकृ ति के  पत्थरों  का उपयोग किया जाता है?
Ans 1. रद्देदार चिनाई (Coursed rubble)

2. शुष्क चिनाई (Dry masonry)

3. वराश्म चिनाई (Ashlar masonry)

4. अनियमित रोड़ी चिनाई (Random rubble)

Q.88 According to the Bureau of Indian Standards, IS 12894:2002, clay and silt in sand for
pulverized fuel-ash lime bricks should preferably be:

Ans 1. 0-5%

2. 6-10%

3. 11-15%

4. 16-20%
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Q.89 निम्न में से किस प्रकार के  बीम का उपयोग छत पर्लिन (roof purlins) और शीटिंग रेल (sheeting rails)
जैसे हल्के  भार वाले बीम के  लिए किया जाता है?

Ans 1. पेटी-गर्डर (Box girders)

2. कोण परिच्छे द (Angles sections)

3. प्लेट गर्डर (Plate girders)

4. जाली पेटा धरन (Castellated beams)

Q.90 वह टीप (pointing) जो जल निकासी की आसान सुविधा प्रदान करती है, ______ होती है।
Ans 1. उभरी टीप (tuck pointing)

2. झिरी टीप (recessed pointing)

3. पख टीप (struck pointing)

4. गोलटीप (beaded pointing)

Q.91 निविदा प्रस्तुत करने की तीन लिफाफा प्रणाली में, पहले लिफाफे  में ________ ।
Ans 1. निर्माण कार्य के  आकलन से संबंधित दस्तावेज होते हैं

2. पात्रता मानदंड से संबंधित दस्तावेज होते हैं

3. तकनीकी बोली होती है

4. वित्तीय बोली होती है

Q.92 पत्थर की चिनाई के  काम के  लिए किस प्रकार का पाड़ सबसे उपयुक्त है?
Ans 1. दोहरी पाड़ (Double scaffolding)

2. एकल पाड़ (Single scaffolding)

3. कैं टिलीवर पाड़ (Cantilever scaffolding)

4. निलंबित पाड़ (Suspended scaffolding)

Q.93 Which of the following boundary conditions for a column results in the lowest effective
length factor (K)?

Ans 1. One end fixed and the other pinned

2. Both ends fixed

3. One end fixed and the other free

4. Both ends pinned

Q.94 पृष्ठ के  पलस्तर में, फं डाई चिनाई (hacking) की प्रक्रिया क्या सुनिश्चित करने के  लिए की जाती है?
Ans 1. पृष्ठ चिकनी हो और सभी प्रकार के  सीमेंट मल से मुक्त हो

2. पलस्तर की सामग्री सही संगति में मिश्रित हो

3. पृष्ठ और पलस्तर के  बीच आबंधन

4. पलस्तर मिश्रण में आर्द्रतांश बना रहे

Q.95 पॉलिमर-मॉडिफाइड कं क्रीट (PMC) में, पॉलिमर घटक की क्या भूमिका है?
Ans 1. भंगुरता को बढ़ाना

2. सामर्थ्य और चिरस्थायित्व को कम करना

3. दृढ़ीकरण काल (setting time) को उल्लेखनीय रूप से बढ़ाना

4. जल की पारगम्यता को कम करना और नम्यता बढ़ाना

Q.96 निम्नलिखित में से कौन-सा किसी पिंड पर लगाए गए बल का प्रभाव नहीं  है?
Ans 1. द्रव्यमान में परिवर्तन

2. गति की दिशा में परिवर्तन

3. गति में परिवर्तन

4. आकृ ति में परिवर्तन
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Q.97 स्टोन ड्रे सिंग (stone dressing) के  लिए उपयोग नहीं  किए जाने वाले औजार (टू ल) की पहचान कीजिए?
Ans 1. मैस हैमर (Mash hammer)

2. मूसल (Pestle)

3. स्प्लिटिंग चिसेल (Splitting chisel)

4. ड्रे  सिंग चाकू  (Dressing knife)

Q.98 ऑटोडेस्क सिविल 3D 2024 यूजर इंटरफे स (Autodesk Civil 3D 2024 user interface) का
निम्नलिखित में से कौन-सा कॉम्पोनेन्ट, फाइल-संबंधित कमांड जैसे फाइलें क्रिएट करना, ओपन करना,
प्रिंट करना, एक्सपोर्ट करना और पब्लिश करना आदि का एक्सेस प्रदान करता है?

Ans 1. रिबन (Ribbon)

2. एप्लिके शन मेनू (Application Menu)

3. टू लस्पेस विंडो (Toolspace Window)

4. कमांड लाइन (Command Line)

Q.99 विशुद्ध बंकन में बंकन समीकरण के  लिए निम्नलिखित में से कौन-सा सही व्यंजक है?

(जहाँ M = बंकन आघूर्ण, I = उदासीन अक्ष के  परित: अनुप्रस्थ-परिच्‍छे द का जड़त्व आघूर्ण, f = उदासीन
अक्ष से y दू री पर बंकन प्रतिबल, y = उदासीन अक्ष से दू री, E = प्रत्यास्थता मापांक, और R = बीम की
वक्रता त्रिज्या)

Ans
1. 

            

2. 

           
           

3. 

           

4. 

           
           

Q.100 किसी बीम में तनन प्रबलन के  प्रतिशत (pt) द्वारा कं क्रीट (c) की डिजाइन अपरूपण सामर्थ्य (design
shear strength) कै से प्रभावित होती है?

Ans 1. तनन प्रबलन में 2% तक की वृद्धि होती है और यदि तनन प्रबलन 2% से अधिक हो जाता है, तो यह घट जाती है

2. तनन प्रबलन प्रतिशत में वृद्धि के  साथ इसमें वृद्धि होती है

3. तनन प्रबलन प्रतिशत से पृथक यह नियत रहती है

4. तनन प्रबलन प्रतिशत में वृद्धि के  साथ यह घट जाती है
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